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Laboratory 2 : Logic gates – hardwired controllers
The aim of this lab is to demonstrate the operation of basic logic gates, their functions 
and how they can be combined to implement different functions i.e. the fundamental 
building blocks of any computer. Each time a computer executes an instruction it has  
to “reconfigure” its hardware, selecting the correct data paths to access the required 
operands (data) and functional units to process this data. These control circuits are 
commonly implemented using a hardwired controller i.e. a combinatorial logic circuit 
specifically designed for a particular instruction set. At the end of this practical you 
will understand how to:

• Define combinatorial logic circuits using schematic capture entry.
• Design simple hardwired controllers from high level pseudo code descriptions.
• Implement combinatorial logic circuits to process input sensor data to control 

output actuators. 
• Understand how multiplexer components are used within a processor. 

Figure 1 : Bug trap 

The University is overrun with cockroaches you are required to design a controller for
an automatic bug trap. The required hardware has already been designed as shown in 
figure 1. This hardware has three main components :

1) Net: a high powered servo motor connected to a square net via a 
connecting arm. When energised the servo pushes the net down into the 
closed position, trapping the cockroach. Otherwise it lifts the net up into 
the open position.

2) Base: this section contains two infra-red illuminated LED sensor modules 
i.e. front and rear sensor, that detect when a cockroach is in the trap. These 
are interfaced to the FPGA via an I2C GPIO expander.

3) Control panel: user console containing a RED status LED, a toggle switch 
and a RED push switch.

To allow you to control this hardware an ISE project called bug_trap_v1 has been 
created and can be downloaded from the module's VLE page. Using your preferred 
web browser download this zip file to c:\temp. Right click on this file selecting 
‘Extract all…’ to unzip it. To start this practical click on the start button and select the 
ISE project navigator.

      -> Xilinx 64bit project navigator 
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This may take a few seconds (a minute when the network is busy) to start. To open 
this project left click on the File pull down within the project navigator window :

File -> Open Project

Then browse to the directory where you unzipped this project and select :
bug_trap_v1.xise. Next, within the Hierarchy window double click on the top 
level schematic bug_trap.sch, as shown below:

This will open the schematic shown in figure 2.

Figure 2 : top level schematic, bug_trap.sch
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This schematic is made up of three components:

• Bug_Trap_Controller : a combinatorial logic circuit that will be incrementally 
developed during this laboratory, processing the input sensor data to control 
output actuators:
◦ Sensor 1 : front sensor, infra-red module 1=empty, 0=bug present.
◦ Sensor 2 : rear sensor, infra-red module 1=empty, 0=bug present.
◦ Mode : toggle switch, 0=down position, 1=up position 
◦ Fire : push switch, 0=pressed, 1=not pressed
◦ OSC : clock oscillator, frequency approximately 1Hz
◦ Servo : servo motor controlling net position, 0=up, 1=down
◦ LED : status display, 0=off, 1=on

• Virtual_Wires : the seven signals controlling the bug trap (listed above) are not
directly connected to the FPGA board as individual wires, rather signals are 
transferred between the FPGA board and the bug trap hardware using a serial 
Inter IC Communications (I2C) Bus, significantly reducing the number of 
wires in the white connecting cable. Note, the reason for this abstraction was 
due to limited IO lines, this is not visible to the bug trap controller. In addition 
to implementing this communications link this component also updates the 
seven segment LED display with the status of these signals. 

• Clock_Divider : the FPGA board has an on board oscillator producing a 
10MHz square wave clock. This is divided down to a slower frequency to 
produce a 1Hz clock on the CLK_OUT pin. This signal will be used later to 
control the servo motor's position.

To test that the bug trap and the FPGA board are working correctly a simple controller
has already been implemented. To open this schematic left click on the 
Bug_Trap_Controller component, highlighting it RED, then on the side toolbar
click on the “push into” symbol icon:

This will open the Bug_Trap_Controller schematic shown in figure 3. In this 
circuit the RED push switch is connected through an inverter to the servo and the 
front panel LED. When this switch is pressed a logic 0 is generated on the FIRE 
signal, this is inverted to produce a logic 1 which will move the servo into the down 
position and illuminate the RED LED.

Figure 3 : top level schematic, bug_trap.sch
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Left click on the top level schematic (highlight), then double click on “Generate 
Programming File” to produce the configuration bit file, as shown in figure 4. Plug in 
the power supply module and connect the USB cable, then configure the FPGA as 
described in Laboratory script 1, pages 9 to 11, using the bug_trap.bit file. 

Figure 4 : generate programming file.

When configured the seven segment LED display will count down from 9 to 0, then 
the servo arm will initialise into the UP position. 

Task : press the RED push switch on the front panel, if the hardware is connected 
correctly the net will move into the down position and the LED will be illuminated.  
The seven segment LED display on the interface PCB should also change as the 
sensors and buttons are activated.

Figure 5 : bug trap operation

Task 1
The data transferred across the I2C bus can be viewed using the oscilloscope. Turn on 
the scope as described in the Laboratory 1 and connect it to the test point shown in 
figure 6. Set the vertical voltage range to 2V per division and the horizontal time base 
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to 50us per division, a typical packet transfer is shown in figure 7. 

Tip, if you do not see the waveform in figure 7 try pressing the ‘Default Setup’ 
and ‘Auto-scale’ buttons. You will need to reposition the trace using the small 
horizontal position knob.

Figure 6 : scope test points.

Figure 7 : I2C data packets

These I2C data packets are used by the FPGA to read the state of the various input 
sensors and to control the output actuators. 

Task : how often are these packets transferred i.e. how quickly is the bug trap 
hardware updated? Tip, you will need to increase the timebase on the scope (ms).

Note, you should see quick changes in the data packet bit values when the push button
is pressed (not persistent). We will not be using the I2C bus directly in these 
laboratories, but we will be looking at different examples of serial data buses in later 
lectures. If you would like more background information on the I2C bus a pdf 
document is available on the VLE.   

From these packets the state of the four input sensors is read and displayed on the 
seven segment display as a hexadecimal value, as shown in figure 8. 

Task : what bit of the this four bit value is each input sensor connected to? Activate 
each infra-red sensor and switch in turn, record the displayed hexadecimal values, 
from this you can determine what bit represents what sensor.
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               Input sensor state                    Output actuator state

Figure 8 : input and output states

Tip, the RED push button is connected to bit 0. As previously discussed when pressed
this bit will be set to a logic zero. Therefore, depending on the state of the other three 
bits the display will be set to the value 0, 2, 4, 6, 8, A, C or E and when it is not 
pressed the value 1, 3, 5, 7, 9, B, D, or F. A hexadecimal to binary conversion table is 
shown in figure 9.

Note, if the infra-red sensors do not change the state of the LED display you will need
adjusted their sensitivity. This can be done by turning the blue variable resistor on 
each module using a small screwdriver (desk draw, green tool case). If you are not 
sure how to do this do ask for assistance.

Figure 9 : Decimal to Hexadecimal conversion tables

Task 2
The current version of the Bug_Trap_Controller only uses the push switch i.e. 
the FIRE button, implementing the following control rules:

DESCRIPTION LOGIC
IF FIRE SERVO = NOT FIRE
THEN LED   = NOT FIRE

CLOSE TRAP
TURN ON LED

ELSE
OPEN TRAP
TURN OFF LED

Remember, the FIRE switch is active LOW, the SERVO and LED are active HIGH. To 
allow the trap to work at night i.e. without human assistance, the front and back 
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infra-red sensors (on base) need to be incorporated into the control rules. In the 
Bug_Trap_Controller component SENSOR_1 is the rear sensor and 
SENSOR_2 is the front sensor as shown in figure 10. The control rules can be 
rewritten as:

DESCRIPTION     LOGIC
IF SENSOR_1 OR SENSOR_2      SERVO = ( (NOT SENSOR_1) OR 
THEN          (NOT SENSOR_2) )

CLOSE TRAP
TURN ON LED     LED   = ( (NOT SENSOR_1) OR 

ELSE          (NOT SENSOR_2) )
OPEN TRAP
TURN OFF LED

                             Rear Sensor                                             Front Sensor

Figure 10 : front and rear infra-red sensors

These control rules could be implemented using an OR gate, as shown in figure 11.

Task : update the schematic bug_trap_controller.sch to match the new 
circuit diagram shown in figure 11. Tip, you will need to delete some of the 
connecting wires and add an additional INV and a OR2 component from the LOGIC 
component category. 

Figure 11 : front and rear infra-red sensors

This circuit can also be represented as the truth table shown in figure 12.
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Sensor 1 Sensor 2 NOT Sensor 1 NOT Sensor 2 Servo LED

0 0 1 1 1 1

0 1 1 0 1 1

1 0 0 1 1 1

1 1 0 0 0 0

Figure 12 : truth table

Task : what single logic gate can be used to implement the same function i.e. replace 
the two INV and OR2 components?

When you have finished entering this circuit left click on the save icon        in the top 
left toolbar in the main window.

Note, logic gates have inputs (on the left) and outputs (on the right) as shown in figure
13. When connecting these logic gates together remember these following rules.

• Input connected to an Input    ->   Ok, but nothing is producing a signal 
• Output connected to an Input    -> Good, signals processed by logic gates
• Output connected to an Output  -> VERY bad, two outputs try to drive 

           different signals onto the same wire.

Figure  13: AND gate, inputs and outputs

To upload this new design into the FPGA double click on “Generate Programming 
File” to produce a new configuration bit file, then configure the FPGA as described in 
Laboratory script 1, using the bug_trap.bit file. If the hardware is configured 
correctly you should now be able to automatically capture your bug, as shown in 
figure 14.

Tip, if it seems that the FPGA has not been updated with the new control rules click 
on Project -> Cleanup Project Files and regenerating the bit file.

Figure  14: automatic triggering
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Task 3
To combine the automatic and manual control rules we need to include the toggle 
switch to select which set of rules should be active i.e. a MODE switch, the selected 
mode is indicated by the LED:

• MODE=0 : manual mode, LED turned on, net controlled by the push button
• MODE=1 : automatic mode, LED turned off, net controlled by either the front 

or the rear infra-red sensor.

These combined control rules can be expressed as:

DESCRIPTION
IF MANUAL
THEN
  TURN ON LED
  IF FIRE
    CLOSE TRAP
  ELSE
    OPEN TRAP
ELSE
  TURN OFF LED
  IF SENSOR_1 OR SENSOR_2
    CLOSE TRAP
  ELSE
    OPEN TRAP

These two sets of rules could be rephrased, combined as shown below: 

DESCRIPTION
IF ( (MANUAL AND FIRE) OR 
     (AUTOMATIC AND (SENSOR_1 OR SENSOR_2)) )
THEN
  CLOSE TRAP
ELSE
  OPEN TRAP

IF MANUAL
THEN
  TURN ON LED
ELSE
  TURN OFF LED

Task : convert the above control rules into a logic circuit. 

Tip, in the above description each bracket is the output of a logic gate, knowing this 
break the description down into a series of gates then reassemble back up into the 
complete circuit e.g.

W = SENSOR_1 OR SENSOR_2 AUTOMATIC = MODE
X = AUTOMATIC AND W MANUAL    = NOT MODE
Y = MANUAL AND FIRE
Z = Y OR X
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Task 4
If all has gone well you should have a circuit comparable to that shown in figure 15.

Figure  15: controller with automatic and manual modes

This circuit can also be represented as the truth table shown in figure 16. When 
MODE=0 i.e. manual mode, only the FIRE button will activate the trap. When 
MODE=1 i.e. automatic mode, either SENSOR will activate the trap. Note, remember 
these input sensors and switches are active when they produce a logic 0 and inactive 
when they produce a logic 1.

Mode Sensor 1 Sensor 2 Fire  Servo  LED

0 0 0 0 1 1

0 0 0 1 0 1

0 0 1 0 1 1

0 0 1 1 0 1

0 1 0 0 1 1

0 1 0 1 0 1

0 1 1 0 1 1

0 1 1 1 0 1

1 0 0 0 1 0

1 0 0 1 1 0

1 0 1 0 1 0

1 0 1 1 1 0

1 1 0 0 1 0

1 1 0 1 1 0

1 1 1 0 0 0

1 1 1 1 0 0

Figure  16: truth table for controller with automatic and manual modes
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Task : update the schematic bug_trap_controller.sch to match your new 
circuit diagram. Double click on “Generate Programming File” to produce the 
configuration bit file. Next. configure the FPGA as described in Laboratory script 1, 
using the bug_trap.bit file. Test that the circuit performs the specified control 
rules.

Task 5
At the heart of the previous controller is a multiplexer, selecting between the manual 
and automatic control rules, as shown in figure 17. 

Figure  17: multiplexer

To simplify the next design this higher level component can be used to minimize the 
amount of drawing. To add an existing schematic and its associated circuit symbol its
.sch and .sym files must be copied to the top level project directory. Using your 
preferred web browser download the files mux_2.sch and mux_2.sym from the 
VLE and save these to your project directory.

To add this component to the project left click on:

Project -> Add Source

This will open the ‘Add Source Wizard’, browse to the project directory and select the
file  mux_2.sch, then click Open. Then click Ok to confirm.

To add this new component to the Bug_Trap_Controller schematic left click on
the “Add Symbol” icon        , within the Categories box you will see the current 
project directory listed, an example (my laptop) is shown in figure 18, this will be 
machine dependent. Select the mux_2 component and add it to the schematic, as 
shown in figure 19.       

Figure  18: local symbols

Mike@simplecpudesign.com  27/03/20

SEL  Y
 0   A
 1   B



Computer Architecture                                                                                                      12

Figure  19: mux_2 symbol (left), schematic (right)

To enter this schematic left click on the mux_2 symbols, then click on the Push into 
Symbol icon     . This will open the mux_2.sch file. To return to the higher level 
schematic click on the Pop to Calling Schematic icon     .

A new breed of heavy weight cockroaches have been discovered. These are longer and
more powerful than your typical bug. If caught these cockroaches can push their way 
through the trap i.e. as we all know cockroaches can not walk backwards. Therefore, 
you need to modify your circuit to implement the following additional rules:

• If the cockroach is small i.e. only covers one of the sensors, the net should 
hold the cockroach in the trap (to minimize the mess).

• If the cockroach is large i.e. covers both of the sensors, the net should 
repeatedly stamp on the bug to ensure it does not “escape”. The 1Hz OSC 
clock input has been provided to help produce this behavior.

The control rules for this new trap could be written as: 

DESCRIPTION
IF (AUTOMATIC)
THEN
  TURN OFF LED
  IF (LARGE)   
  THEN
    STAMP ON BUG   
  ELSIF (SMALL)
  THEN
    CLOSE TRAP
  ELSE
    OPEN TRAP
ELSE
  TURN ON LED
  IF (FIRE)
  THEN
    CLOSE TRAP
  ELSE
    OPEN TRAP

These rules can be implemented in a number of different ways. You could 
consider each decision point i.e. IF statement, as an input to a multiplexer, as 
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shown in figure 20.

Figure  20: multiplexer based implementation

Multiplexer mux_2a controls the LED. The MODE signal from the toggle switch 
selecting a constant logic 1 (VCC) when in manual mode (MODE=0) and a constant 
logic 0 (GND) when in automatic mode (MODE=1). 

Note, the symbols for constant logic 1 (VCC) and a constant logic 0 (GND) can be 
found in the General symbol category.

Multiplexer mux_2d controls the servo, selecting between the manual control rules 
on its A input and the automatic control rules on its B input.

Multiplexers mux_2b and  mux_2c implement the automatic control rules. If the 
cockroach is LARGE input B of  mux_2c is selected, else input A. This input is 
connected to the output of  mux_2b, selecting between the SMALL and no bug 
present rules.

Task : the schematic in figure 20 can be downloaded from the VLE. Copy this to the 
project directory, overwriting the previous Bug_Trap_Controller schematic. 
Then edit this circuit diagram replacing the      boxes shown in figure 20 (removed in 
the downloaded schematic) with the correct logic circuits to implement the required 
control rules.

Tip, you need to select the correct logic gates to generate these control signals:

• LARGE : produce a logic 1 when the bug triggers both sensors at the same 
time, else a logic 0.

• SMALL : produce a logic 1 when either sensor is triggered, but not if both are 
triggered, else a logic 0.

To help simplify the logic design you may want to invert the input sensors and switch 
signals to make them active high e.g. a sensor produces a logic 1 when a bug is in the 
trap rather than a logic 0. Only one logic gate is needed to generate each control 
signal. These control signals will be connected to the select lines of multiplexers 
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mux_2b and  mux_2c, their inputs are then connected to the correct sensor signals or
logic state as defined in the updated control rules. The OSC input produces a square 
wave i.e. a signal that repeatedly alternates between a logical 1 and a logical 0. Using 
this input can you change the behavior of the trap so that when triggered it will 
repeatedly squash (stamps on) the bug instead of just holding it.

To verify the operation a VHDL test bench bug_trap_tb.vhd can be downloaded 
from the VLE. Save this file to the project directory. To add this component to the 
project left click on:

Project -> Add Source

This will open the ‘Add Source Wizard’, browse to the project directory and select 
this file, click Open. Next, update the Association to Simulation, then click Ok to 
confirm, as shown below.

Figure  21: associating file with simulation 

Left click on the ‘Design’ tab (project navigator window, bottom left) to display 
project ‘sources’. Click on the ‘Simulation’ radio button, ensuring ‘Behavioral’ 
simulation is selected, as shown in figure 22. 

Left click (highlight) on the testbench file bug_trap_TB, this will update the 
‘Processes for’ source window, then double left click on ‘Simulate Behavioural 
Model’ to launch the simulation.

Figure  22: launching simulation

Figure  23: simulation controls
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The VHDL simulator allows the operation of the circuit to be checked by examining 
its waveform timing diagram. Update the simulation time to 4us, then click on the 
Run simulation for      icon. If  operating correctly the Servo and LED signals should 
match those shown in figure 24. 

Figure  24: multiplexer based simulation

To upload this new design into the FPGA double click on “Generate Programming 
File” to produce a new configuration bit file, then configure the FPGA as described in 
Laboratory script 1, using the bug_trap.bit file. Download this into the FPGA to 
confirm your solution is working correctly.

Summary
The logic circuit in task 5 uses one of the main building blocks found within a 
computer i.e. the multiplexer (MUX), an electronic switch used to route data from one
point in a processor to another. Within the bug trap circuit it is used to select either the
manual or automatic control logic, as shown in figure 25. To simplify circuit diagrams
a multiplexer is commonly represented using a distinctive trapezoid shaped 
component symbol.

Figure 25: multiplexer

The operation of this multiplexer is controlled by the toggle switch MODE i.e. the 
select (SEL) signal. This signal and its inverse are combined with AND gates, as 
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shown in figure 17, therefore, one AND gate will always have a logic 0 on its input 
allowing the SEL signal to mask one multiplexer input and select data from the other, 
as shown by these logical relationships:

A AND 0 = 0
A AND 1 = A 

The final OR gate acts as a joining function merging the outputs of the two AND gates 
onto a single output, as only a single AND gate will produce a logical 1 at any time. 
The truth table of this two input multiplexer is shown in figure 26.

SEL  IN0  IN1    OUT     Description

  0   0   0      0     Select IN0

  0   0   1      0     Select IN0

  0   1   0      1     Select IN0

  0   1   1      1     Select IN0

  1   0   0      0     Select IN1

  1   0   1      1     Select IN1

  1   1   0      0     Select IN1

  1   1   1      1     Select IN1

Figure 26: Multiplexer truth table

The combination of control logic and multiplexers form the core of most computers 
i.e. hardware circuits that can work out what each instruction should do and then 
select the required data to be processed. 

IMPORTANT, if your project directory is on the C drive don't forget to copy it to 
your home directory, otherwise you may loose your work.
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